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| ntroduction

This document describes Cisco's Customer Experience (CX) Cloud Agent. Cisco's CX Cloud Agentisa
highly scalable platform that collects telemetry data from customer network devices to deliver actionable
insights for customers. CX Cloud Agent enables the Artificial Intelligence (Al)/Machine Learning (ML)
transformation of active running configuration data into proactive and predictive insights displayed in CX
Cloud.
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This guideis specific to CX Cloud Agent v2.4. Refer to the Cisco CX Cloud Agent page to access prior

Versions.


https://www.cisco.com/c/en/us/support/cloud-systems-management/cx-collector/series.html

Note: Imagesin this guide are for reference purposes only. Actual content can vary.

Prerequisites

CX Cloud Agent runsas a Virtual Machine (VM) and is available for download as an Open Virtual
Appliance (OVA) or aVirtual Hard Disk (VHD).

Deployment Requirements

» One of the following hypervisorsisrequired for a new install:
- VMware ESXi v5.5 or later

- Oracle Virtual Box v5.2.30 or later

- Windows Hypervisor version 2012 to 2022

» The configurationsin the following table are required for deploying VM:

CX Cloud Agent
Deployment Type

Number of CPU
Cores

RAM

Hard Disk

* Maximum number of Assets
directly connected to CX Cloud




Agent

Small OVA 8C 16GB 200GB 10,000
Medium OVA 16C 32GB 600GB 20,000
Large OVA 32C 64GB 1200GB 50,000 :

*n addition to connecting 20 Cisco Catalyst Center (Catalyst Center) non-clusters or 10 Catalyst Center
clusters for each CX Cloud Agent instance.

Note: Flexible OV A/Patch 2.4 for medium and large configurations is available only for the
VMware ESXi VMs. The Oracle VirtualBox and Windows Hyper-V cannot be used for medium
and large configurations.

» For customers using designated US data centers as the primary data region to store CX Cloud data, the



CX Cloud Agent must be able to connect to the servers shown here, using the Fully Qualified Domain
Name (FQDN), and using HTTPS on TCP port 443:
- FQDN: agent.us.csco.cloud
- FQDN: ng.acs.agent.us.csco.cloud
- FQDN: cloudsso.cisco.com
- FQDN: api-cx.cisco.com
 For customers using designated Europe data centers as the primary data region to store CX Cloud
data: the CX Cloud Agent must be able to connect to both of the servers shown here, using the FQDN,
and using HTTPS on TCP port 443:
- FQDN: agent.us.csco.cloud
- FQDN: agent.emea.csco.cloud
- FQDN: ng.acs.agent.emea.csco.cloud
- FQDN: cloudsso.cisco.com
- FQDN: api-cx.cisco.com
» For customers using designated Asia Pacific data centers as the primary data region to store CX Cloud
data: the CX Cloud Agent must be able to connect to both of the servers shown here, using the FQDN,
and using HTTPS on TCP port 443:
- FQDN: agent.us.csco.cloud
- FQDN: agent.apjc.csco.cloud
- FQDN: ng.acs.agent.apjc.csco.cloud
- FQDN: cloudsso.cisco.com
- FQDN: api-cx.cisco.com
 For customers using designated Europe and Asia Pacific data centers as their primary data region,
connectivity to FQDN: agent.us.csco.cloud isrequired only for registering the CX Cloud Agent with
CX Cloud during initial setup. After the CX Cloud Agent is successfully registered with CX Cloud,
this connection is no longer required.
* For local management of the CX Cloud Agent, port 22 must be accessible.
» Thefollowing table provides a summary of the ports and protocols that must be opened and enabled
for CX Cloud Agent to function correctly:

CX Cloud Agent Traffic

Source Destination Protocol  Port

Allregions:
cloudsso.cisco.com

api-cx.cisco.com
agent us.csco.cloud

DNA Center . - =
’ Initial configuration Bi-directional to
AMER region Cisco AWS regional
R ] ] 1o ey o - z L -~ - [%
CX Cloud Agent " Anrg ai(;r,‘flgent us.csco.cloud HTTPS | TCP[443 uUpgrades data centersand
E_EJQ_O_.agem R —— Inventory & telemetry transfers DNA Center

ng.acs.agent.emea.csco.cloud
APJC reqion:

agentapjc.csco.cloud

ng.acs.agent apic.csco.cloud

. . Initialdiscovery
CX Cloud Agent Metwork Devices SNMP | UDP/161 Outbound to LAN
Ongoing inventory collections

CX Cloud Agent MNetwork Devices S5H TCP/22 Collection of telemetry from CLI commands Qutbound to LAN
CX Cloud Agent Metwork Devices Telnet TCP/23 Collection of telemetry from CLI commands Outbound to LAN
Network Devices CX Cloud Agent Syslog UDP/514 Transfer syslogs for Alert Fault Management Inbound from LAN

Workstation CX Cloud Agent SSH TCPf22 CX Cloud Agent Maintenance Inbound from LAN

* AnlIPisautomatically detected if the Dynamic Host Configuration Protocol (DHCP) is enabled in the
VM environment; Otherwise, afree |Pv4 address, Subnet mask, Default Gateway |P address, and
Domain Name Service (DNS) server IP address must be available.

* Only IPv4 is supported.



» The certified single node and High Availability (HA) Cluster Catalyst Center versions are 2.1.2.x to
2.2.3.X, 2.3.3%, 2.3.5.x, 2.3.7.x and Catalyst Center Virtual Appliance and Catalyst Center Virtual

Appliance.

* If the network has SSL interception, permit-list CX Cloud Agent’s |P address.

 For all directly connected assets, SSH privilege level 15 isrequired.
» Useonly the provided hostnames; static |P addresses cannot be used.

Accessing Critical Domains

To start the CX Cloud journey, users require access to the following domains. Use only the hostnames
provided; do not use static |P addresses.

Domains Specific to the CX Cloud Agent Portal

Major Domains

Other Domains

csco.cloud cloudfront.net
eum-appdynamics.com
appdynamics.com
split.io

tigcdn.com

jquery.com

Domains Specific to CX Cloud Agent OVA

AMERICAS

EMEA

APJC

cloudsso.cisco.com

cloudsso.cisco.com

cloudsso.cisco.com

api-cx.cisco.com

api-cx.cisco.com

api-cx.cisco.com

agent.us.csco.cloud

agent.us.csco.cloud

agent.us.csco.cloud

ng.acs.agent.us.csco.cloud

agent.emea.csco.cloud

agent.apjc.csco.cloud

ng.acs.agent.emea.csco.cloud

ng.acs.agent.apjc.csco.cloud




N Note: The outbound access must be allowed with redirection enabled on port 443 for the specified
FQDN's.

Catalyst Center Supported Version

Supported single node and HA Cluster Catalyst Center versionsare 2.1.2.x t0 2.2.3.x, 2.3.3.X, 2.3.5.X,
2.3.7.x and Catalyst Center Virtual Appliance and Catalyst Center Virtual Appliance.
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Supported Browsers

For the best experience on Cisco.com, the latest official release of these browsers is recommended:
» Google Chrome

» Microsoft Edge
* MozillaFirefox

Supported Product List

To view thelist of products supported by CX Cloud Agent, refer to the Supported Product List.

Upgrading/Installing CX Cloud Agent v2.4

» Existing customers upgrading to the new version should refer to Upgrade CX Cloud Agent v2.4.
* New customersimplementing afresh flexible OVA v2.4 install should refer to Adding CX Cloud
Adgent as Data Source.

Upgrading Existing VMsto Large and Medium Configuration

Customers can upgrade their existing VM configuration to medium or large using Flexible OV A options
based on their network size and complexity.

To upgrade the existing VM configuration from small to medium or large, refer to section Upgrading CX
Cloud Agent VMs to medium and large configuration.



https://www.cisco.com/c/en/us/support/docs/cx/cx-cloud/cx217693-supported-product-list.html

Upgrade CX Cloud Agent v2.4

Customers running CX Cloud Agent v2.3.x and above can follow the steps in this section to directly upgrade
tov2.4.

Note: Customers on CX Cloud Agent v2.2.x should upgrade to v2.3.x before upgrading to v2.4 or
install the v2.4 as fresh OVA install.

To install the CX Cloud Agent upgrade v2.4 from CX Cloud:

1. Login CX Cloud. The Home page displays.


https://cx.cisco.com/
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2. Click the Admin Center icon. The Data Sour ces window opens displaying CX Cloud Agent as an
existing data source.
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3. Click the CX Cloud Agent data source. The CX Cloud Agent details window opens.
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Data Sources Detail View

4. Click the Softwar e tab.
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CX Cloud Agent Detail View

5. Select the software version 2.4.0 from Choose a softwar e ver sion to update to drop-down.
6. Click Install Updatetoinstall CX Cloud Agent v2.4.0.



Note: Customers can schedule the update for later by clearing the Install Now check box which
displays scheduling options.

Adding CX Cloud Agent

Customers can add up to twenty (20) CX Cloud Agent instances in CX Cloud.

To add aCX Cloud Agent:



Note: Repeat the following steps to add additional CX Cloud Agent instances as a data source.

1. Loginto CX Cloud. The Home page displays.


https://cx.cisco.com/
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CX Cloud Home Page

2. Select the Admin Center icon. The Data Sour ces window opens.
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Data Sources

3. Click Add Data Source. The Add Data Sour ce window opens. The options displayed vary based on

customer subscriptions.
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Add Data Source
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Add Data Source

4. Click Add Data Sour ce from the CX Cloud Agent option. The Set Up CX Cloud Agent window
opens.



Expand Your CX Cloud Insights
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Set Up CX Cloud Agent

5. Review the Review deployment requirements section and select the | set up this configuration on
port 443 check box.

6. Click Download on Cisco.com. The Softwar e Download page opens.

7. Download the CX Cloud Agent v2.4 OVA file.



Note: A Pairing Code, required to complete the setup of the CX Cloud Agent, is generated
after deploying the OV A file.

8. Enter the CX Cloud Agent name in the Name Your CX Cloud Agent field.
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9. Click Continue. The Deploy and pair with your virtual machine window opens.
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Deploy and Pair with Your Virtual Machine

10. Enter the Pairing Code received after deployment of the downloaded OV A file.



11. Click Continue. The registration progress displays, followed by a confirmation.

Adding Catalyst Center as Data Source

To add Catalyst Center as data source:

1. Click Add Data Sourcein the Admin Center > Data Sour ces window.

Add Data Source

{@ Catabyst Center

" Cisco Catalyst SD-WAN Mandger

Contracts
CX Cloud Agent

Firenwall Managerment Center

® Infgrssght

Oithesr Assets by IP Ranges

Other Assets by Seed File

[+

Add Data Source

2. Click Add Data Sour ce from the Catalyst Center option.



Which CX Cloud Agent Do You Want to Connect to?
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3. Select the CX Cloud Agent from the Which CX Cloud Agent Do You Want to Connect to drop-
down list.
4. Click Continue. The Connect to CX Cloud window opens.
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Connect to CX Cloud

5. Enter the following details:
* Virtual IP Addressor FQDN (i.e,Catalyst Center IP Address),
City (i.e., Catalyst Center’s location),
Username
Passwor d
Frequency, Time, and Time Zone to indicate how often the CX Cloud Agent should perform
network scansin Schedule Inventory Collection sections



Note:Select Run thefirst collection now checkbox to run the collection now.

6. Click Connect. A confirmation displays with the Catalyst Center |IP Address.

Adding Other Assets as Data Sour ces

Telemetry collection has been extended to devices not managed by the Catalyst Center, enabling
customersto view and interact with telemetry-derived insights and analytics for a broader range of devices.
After the initial CX Cloud Agent setup, users have the option to configure CX Cloud Agent to connect to 20
additional Catalyst Centers within the infrastructure monitored by CX Cloud.

Users can identify devices to incorporate into CX Cloud by uniquely identifying such devices using a seed
file or by specifying an IP range, which can be scanned by CX Cloud Agent. Both approaches rely on
Simple Network Management Protocol (SNMP) for the purpose of discovery (SNMP) and on Secure Shell
(SSH) for connectivity. These must be properly configured to enable successful telemetry collection.

To add other assets as data sources:

» Upload a seed file using a seed file template.
* Provide an IP address range.

Discovery Protocols



Both seed file-based direct device discovery and I P range-based discovery rely on SNMP as the discovery
protocol. Different versions of SNMP exist, but CX Cloud Agent supports SNMPV2c and SNMP V3 and
either or both versions can be configured. The same information, described next in complete detail, must be
provided by the user to complete configuration and to enable connectivity between the SNM P-managed
device and SNMP service manager.

SNMPV2c and SNMPV 3 differ in terms of security and remote configuration model. SNMPV 3 uses an
enhanced cryptographic security system supporting SHA encryption to authenticate messages and ensure
their privacy. It is recommended that SNMPv3 be used on all public and internet-facing networks to protect
against security risks and threats. On CX Cloud, it is preferred that SNMPv3 be configured and not
SNMPv2c, except for older legacy devices that lack built-in support for SNMPv3. If both versions of SNMP
are configured by the user, CX Cloud Agent can, by default, attempt to communicate with each respective
device using SNMPv3 and revert to SNMPv2c if the communication cannot be successfully negotiated.

Connectivity Protocols

As part of the direct device connectivity setup, users must specify details of the device connectivity

protocol: SSH (or, alternatively, telnet). SSHv2 can be used, except in the cases of individual legacy assets
which lack the appropriate built-in support. Be aware that SSHv1 protocol contains fundamental
vulnerabilities. Absent additional security, telemetry data and the underlying assets can be compromised due
to these vulnerabilities when relying on SSHv1. Telnet is also insecure. Credential information (usernames
and passwords) submitted through telnet are not encrypted and therefore vulnerable to compromise, absent
additional security.

Telemtery Processing Limitation for Devices

The following are limitations when processing telemetry data for devices:

» Some devices may show as reachable in the Collection Summary but are not visible in the CX Cloud
Assets page. Device instrumentation limitations prevent the processing of such devices telemetry.

 If adevice from the seed file or IP range collections is also part of the Cisco Catalyst Center
inventory, the device is reported only once for the Cisco Catalyst Center entry. The respective devices
within the seed file/I P range entry are skipped to avoid duplication.

Adding Other AssetsUsing a Seed File

A seed fileisa.csv file where each line represents a system data record. In a seed file, every seed file record
corresponds to a unique device from which telemetry can be collected by CX Cloud Agent. All error or
information messages for each device entry from the seed file being imported are captured as part of job log
details. All devicesin a seed file are considered managed devices, even if the devices are unreachable at the
time of initial configuration. In the event a new seed file is being uploaded to replace a previous one, the
date of last upload is displayed in CX Cloud.

CX Cloud Agent can attempt to connect to the devices but cannot be able to process each one to show in the
Assets pages in cases where it is not able to determine the PIDs or Serial Numbers.Any row in the seed file
that starts with a semicolon isignored. The header row in the seed file starts with a semicolon and can be
kept as is (recommended option) or deleted while creating the customer seed file.

It isimportant that the format of the sample seed file, including column headers, not be altered in any way.
Click the link provided to view a seed filein PDF format. This PDF isfor reference only and can be used to
create a seed file that needs to be saved in .csv format.

Click thislink to view a seed file that can be used to create a seed filein .csv format.


https://www.cisco.com/c/dam/en/us/support/docs/cloud-systems-management/cx-cloud-agent/seed-file-template.pdf

% Note: This PDF isfor reference only and can be used to create a seed file that needsto be saved in

.csv format.

Thistable identifies al necessary seed file columns and the data that must be included in each column.

Seed File Column

Column Header / | dentifier

Pur pose of the Column

|P Address or hostname

Provide avalid, unique IP Address or hostname of
the device.

SNMP protocol version

The SNMP protocol isrequired by CX Cloud
Agent and is used for device discovery within the
customer network. Values can be snmpv2c or
snmpv3, but snmpv3 is recommended due to
security considerations.

snmpRo : Mandatory if col#=3
selected as 'snmpv2c'

If the legacy variant of SNMPv2 is selected for a
specific device, then so mpRO (read only)
credentials for the device SNMP collection must be
specified. Otherwise, entry can be blank.

snmpv3UserName : Mandatory
if col#=3 selected as 'snmpv3'

If SNMPVv3 is selected to communicate with a
specific device, then the respective login username
must be provided.

snmpv3AuthAlgorithm : values
can be MD5 or SHA

SNMPv3 protocol permits Authentication via either
the MD5 or SHA Algorithm. If the deviceis
configured with secure Authentication, then the
respective Auth Algorithm must be provided.

Note: MD5 is considered insecure, and
SHA can be used on all devices that




Seed File Column

Column Header / | dentifier

Purpose of the Column

support it.

snmpv3AuthPassword :
password

If either aMD5 or a SHA cryptographic algorithm
is configured on the device, then the relevant
Authentication password needs to be provided for
device access.

snmpv3PrivAlgorithm : values
can be DES, 3DES

If the deviceis configured with the SNMPv3
privacy algorithm (this algorithm is used to encrypt
the response), then the respective Algorithm needs
to be provided.

Note: 56-bit keys used by DES are
considered too short to provide
cryptographic security, and that 3DES can
be used on all devices that support it.

snmpv3PrivPassword :
password

If the SNMPv3 privacy algorithm is configured on
the device, then its respective privacy password
needs to be provided for device connection.

snmpv3Engineld : enginel D,
unique ID representing device,
specify engine ID if manually
configured on device

The SNMPv3 Enginel D isaunique ID representing
each device. Thisengine ID is sent as areference
while collecting the SNMP datasets by CX Cloud
Agent. If the customer configures the EnginelD
manually, then the respective Enginel D needs to be
provided.




Seed File Column

Column Header / | dentifier

Purpose of the Column

cliProtocol: values can be
'telnet’, 'sshvl’, 'sshv2'. If

The CLI isintended to interact with the device
directly. CX Cloud Agent uses this protocol for
CL1I collection for a specific device. This CLI
collection datais used for Assets and other Insights

J . . Reporting within CX Cloud. SSHv2 is
Srgga/tcan Setto 'sshv2' by recommended; absent other network security
measures, in themselves SSHv1 and Telnet
protocols do not provide adequate transport
Ssecurity.
. ) If any CLI Protocol is selected, its respective port
K ?‘IL';%; CLI protocol port number needs to be provided. For example, 22 for
SSH and 23 for telnet.
g;_llJ?Jerserr?alFrllelleer nag:g (()?ther The respective CLI username of the device needs to
passw be provided. Thisisused by CX Cloud Agent at the
L BOTH can be provided, BUT | : ) .
time of connecting to the device during CLI
both columns (col#=12 and collection
col#=13) cannot be empty.) '
cliPassword : CLI user
password (either CLI The respective CLI password of the device needsto
M username/password or BOTH |be provided. Thisisused by CX Cloud Agent at the,
can be provided, BUT both time of connecting to the device during CLI
columns (col#=12 and collection.
col#=13) cannot be empty.)
If enableis configured on the device, then the
N cliEnableUser device' s enableUsername value needs to be
provided.
If enableis configured on the device, then the
O cliEnablePassword device' s enablePassword value needs to be
provided.
P Futu_r e Support (No Inputs Reserved for Future Use
required)
Q Futu_r & Support (No Inputs Reserved for Future Use
required)
R Future Support (No Inputs Reserved for Future Use

required)




Seed File Column Column Header / Identifier |Purpose of the Column

Future Support (No Inputs

X Reserved for Future Use
required)

Add Other AssetsUsing a New Seed File

To add other assets using a new seed file:

1. Click Add Data Sourceinthe Admin Center > Data Sour ces window.

Add Data Source

m Catabyst Center

Cisco Catahyst SD-WAN Manager

Coniracis
CX Cloud Agent

Firewall Management Conter

@ Intersight

Ortheesr Aggets by IP Ranges

Other Asaats by Sead ke

]

Add Data Source

2. Click Add Data Sour ce from the Other Assets by Seed File option.



Which CX Cloud Agent Do You Want to Connect to?

Select option = .r||,|l|."-*
cisco il -
L2
Cancel
Select CX Cloud Agent

3. Select the CX Cloud Agent from the Which CX Cloud Agent Do You Want to Connect to drop-
down list.

Which CX Cloud Agent Do You Want to Connect to?

NG _Team_test_CXG m_IP_104 v _
il ) a0
ciscoll B
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Continue

4. Click Continue. The Upload Your Seed File page displays.



Upload your seed file

Diovemnboad the seed file template and add your dévice information. Then attach the file beloe.

T

Dirag and drop o B flas

Schedule immentory collection

12:00 - Ak v Europa/Amsierdam |

B Run the first collection now (this may take up to 75 minutes)

Upload Your Seed File

5. Click the hyperlinked seed file template to download the template.

6. Manually enter or import data into the file. Once complete, save the template as a.csv file to import
thefileinto CX Cloud Agent.

7. Drag-and-drop or click browse files to upload the .csv file.

8. Complete the Schedule inventory collection section.



Note: Beforeinitial configuration of CX Cloud is completed, CX Cloud Agent must perform
the first telemetry collection by processing the seed file and establishing connection with all
identified devices. Collection can beinitiated on-demand or run according to a schedule
defined here. Users can perform the first telemetry connection by selecting the Run the first
collection now check box. Depending on the number of entries specified in the seed file and
other factors, this process can take a considerable amount of time.

9. Click Connect. The Data Sour ces window opens, displaying a confirmation message.
Add Other AssetsUsing a Modified Seed File
To add, modify, or delete devices using the current seed file:
1. Open the previously created seed file, make required changes, and save thefile.
% Note: To add assets to the seed file, append those assets to the previously created seed file and
reload the file. Thisis necessary since uploading a new seed file replaces the current seed file.

Only the latest uploaded seed file is used for discovery and collection.

2. From the Data Sour ces page, click the CX Cloud Agent data source that requires an updated seed file.
The CX Cloud Agent details window opens.
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CX Cloud Agent Details window

3. Click Replace Seed File.
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CX Cloud Agent window

4. Drag-and-drop or click browse filesto upload the modified seed file.
5. Click Upload.

Add Other Assets Using | P Ranges

IP ranges allow users to identify hardware assets and, subsequently, collect telemetry from those devices
based on | P addresses. The devices for telemetry collection can be uniquely identified by specifying asingle
network-level 1P range, which can be scanned by CX Cloud Agent using the SNMP protocol. If the P range
is chosen to identify a directly connected device, the | P addresses that are referenced can be as restrictive as
possible, while allowing coverage for al required assets.

» Specific IPs can be provided, or wildcards can be used to replace octets of an |P to create arange.



 If aspecific IP addressis not included in the I P range identified during setup, CX Cloud Agent does
not attempt to communicate with a device that has such an IP address, nor does it collect telemetry
from such a device.

» Entering *.*.*.* allows CX Cloud Agent to use the user-supplied credential with any IP. For example:
172.16.* .* adlowsthe credentials to be used for al devicesin the 172.16.0.0/16 subnet.

* If there are any changesto the network or Installed Base (1B), the I P range can be modified. Refer to
section Editing IP Ranges

CX Cloud Agent will attempt to connect to the devices but may not be able to process each oneto show in
the Assetsview in cases where it is not able to determine the PIDs or Serial Numbers,

% Notes:

Clicking Edit I P Address Range initiates on-demand device discovery. When any new deviceis
added or deleted (within or outside) to a specified IP-range, customer must always click Edit I P
Address Range (refer to section Editing IP Ranges) and complete the steps required for initiating the
on-demand device discovery to include any newly added device to the CX Cloud Agent collection
inventory.

Adding devices using an I P range requires users to specify all applicable credentials through the
configuration Ul. The fields visible vary depending on the protocols selected on the previous windows. 1
multiple selections are made for the same protocol, for example, selecting both SNMPv2c and SNMPv3 or
selecting both SSHv2 and SSHv1, CX Cloud Agent automatically auto-negotiates the protocol selection
based on the individual device capabilities.

When connecting devices using I P addresses, customer should ensure all relevant protocolsin the IP range
along with SSH versions and Telnet credentials are valid or the connections will fail.

Adding Other Assets by IP Ranges

To add devices using the | P range:

1. Click Add Data Sourceinthe Admin Center > Data Sour ces window.
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2. Click Add Data Sourcein the Other Assets by I P Ranges option.
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Which C¥ Cloud Agent Do You Want to Connect 1o?

=
sl iai i ¥
cisco i ]
L

=L

Select CX Cloud Agent

3. Select the CX Cloud Agent from the Which CX Cloud Agent Do You Want to Connect to drop-

down list.
4. Click Continue. The Select Y our Protocol window opens.
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5. Select the applicable check boxes for Discovery options and Collection options.
6. Click Continue.
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Schedule Inventory Collection
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Provide Discovery Details and Schedule Inventory Collection Sections

7. Enter the required detailsin the Provide Discovery Details and Schedule Inventory Collection
sections.



Note: To add another 1P range for the selected CX Cloud Agent, click Add Ancther IP
Range to navigate back to the Set Y our Protocol window and repeat the stepsin this section.

8. Click Complete Setup. A confirmation displays upon successful deployment.
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Confirmation Message
Editing I P Ranges
To edit an IP range:

1. Navigate to the Data Sour ces window.
2. Click the CX Cloud Agent that requires IP range edit in Data Sour ces. The details window opens.
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Data Sources

3. Click Edit 1P Address Range. The Connect to CX Cloud window opens.
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Provide Discovery Details

4. Click Edit the protocols. The Select Your Protocol window opens.



¢ Back

Added IP Address Ranges (4)

Select Your Protocol

5. Select the appropriate check boxes to choose applicable protocols and click Continue to navigate

Select Your Protocol
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back to the Provide Discovery Details window.
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Provide Discovery Details

6. Edit the details as required and click Complete Setup. The Data Sour ces window opens, displaying a
message confirming the addition of newly added |P Address range(s).



Note: This confirmation message does not verify whether devices within the modified range are
reachable or if their credentials are accepted. This confirmation occurs when the customer initiates
the discovery process..
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Deleting I P Range

To delete an IP range:

1. Navigate to the Data Sour ces window.
2. Select the respective CX Cloud Agent with the | P range that needs to be deleted. The details window
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3. Click Edit 1P Ranges. The Provide Discovery Details window opens.
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Provide Discovery Details

4. Click the Delete this 1P range link. The confirmation message displays.

F A

Delete This IP Range

Any edits you've made won't be saved.

=

Continue Editing | Delete
-

b A

Confirmation Delete Message

5. Click Delete.
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6. Click Save. The processing message displays.
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7. Click Open a Case to create a case to delete the assets associated with the IP range. The Data
Sour ces window opens, displaying a confirmation message.

About Devices Discovered from Multiple Controllers

It is possible that some devices could be discovered by both the Cisco Catalyst Center and direct device
connection to CX Cloud Agent causing duplicate data to be collected from those devices. To avoid
collecting duplicate data and having only one controller manage the devices, a precedence for which CX
Cloud Agent manages the devices needs to be determined.

» If adeviceisfirst discovered by Cisco Catalyst Center and then rediscovered by direct device
connection (using aseed file or an IP range), Cisco Catalyst Center takes precedence in controlling the
device.

» If adeviceisfirst discovered by direct device connection to CX Cloud Agent and then rediscovered
by Cisco Catalyst Center, Cisco Catalyst Center takes precedence in controlling the device.

Scheduling Diagnostics Scans

Customers can schedule on demand diagnostic scansin CX Cloud.



Note: Cisco recommends scheduling diagnostic scans or initiating on-demand scans at least 6-7
hours apart from inventory collection schedules so they do not overlap. Executing multiple
diagnostic scans simultaneously can slow the scanning process and potentially result in scan

failures.

To schedule diagnostic scans:

1. On the Home page, click the Settings (gear) icon.
2. On the Data Sour ces page, select Data Collection in the left pane.

3. Click Schedule Scan.
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Data Collection

4. Configure a schedule for this scan.

Other assets collected by CX Cloud Agent Inventory Collection Details

Schedule History

Wigakly = pn Sunday L ar 12:00 am ~  EOT

Created: Oct 3, 2022

- . R
{f Sawve Scheduled Collection
b -

Configure Scan Schedule

5. Inthe deviceslist, select all devices for the scan and click Add.




Hew Scheduled Scan

Dats Soarces Sohduig
Do Sanace P hdaerai
M
b &
i i L )
Schedule a Scan

6. Click Save Changes when the scheduling is complete.

The Diagnostic Scans and the Inventory Collection schedules can be edited and deleted from the Data

Collection page.

Data Collection

Diagnostic Scans

2 Scans
Asset Count Source Schedule
(" 1 10.127.249.152 Mot scannable
10 10.127.249.152 Daily at 07:00 PM IST

"
Inventory Collection
B Collections
Source Schedule
Other assets collected by CX Cloud Agent Daily a1 04:00 AM IST
1 Daily 3t 12:30 AK IST
172.20.224.70/Tve cisco.com Monthly on the Sth at 11:30 PM IST
C;J 10.127.289.152 Daily at 02:00 AM IST

Data Collection with Edit and Delete Schedule Options

{ Schedule Scan )

Edit Schedule

Delete Schedule
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Once VMs are upgraded, it is not possible to:

» Downscale from alarge or medium to asmall configuration
» Downscale from alarge to medium configuration
» Upgrade from a medium to large configuration

Prior to upgrading the VM, Cisco recommends taking a snapshot for the purpose of recovery in case of
failure. Refer to Backing Up and Restoring the CX Cloud VM for more details.

Reconfiguring Using VMwar e vSphere Thick Client

To upgrade the VM configuration using existing VMware vSphere Thick Client:



(5 VMware vSphere Client X
vmware

VMware vSphere
Client

'_L‘L All vSphere features introduced in vSphere 5.5 and beyond are
avalable only through the vSphere Web Chent. The traditional
vSphere Chent will continue to operate, supporting the same
feature set as vSphere 5.0.

To drectly manage a single host, enter the IP address or host name.
To manage multple hosts, enter the IP address or name of 3
vienter Server.

IP address [ Name:  |: i

User name: '

Password: |

[ Use Windows session credentials

vSphere Client

1. Login to the VMware vSphere Client. The Home page displays alist of VMs.
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Edit Settings

. Right-click the target VM and select Edit Settings from the menu. The VM Proper ties window
opens.
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VM Properties

3. Update the Memory Size values as specified:
Medium: 32 GB (32768 MB)

Large: 64 GB (65536 MB)

4. Select CPUs and update the values as specified:
Medium: 16 core (8 sockets * 2 core/socket)
Large: 32 core (16 sockets * 2 core/socket)

5. Click Add. The Add Har dwar e window opens.



@ CiCloudigent 2.2 Build-35 wvishau_10.126.77.136_dev - Virtual Machine Properties

Virtual Machine Version: 8

™| (3 Add Hardware

Device Type
What sort of device do you wish to add to your virtual machine?

Device Type Choase the type of device you wish to add,
Ready to Complete

Serial Port (unavadable) ~ Information
Paralel Port (unavalable)
Floppy Drive: (unavadable)
CODVD Drive {unavalable )
USB Controller

USE Device [unavailable)
PO Device [ursvadabie)

< Bhck

e |

e |

Device Type

6. Select Hard Disk asthe Device Type.
7. Click Next.
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Hardware | Options | Resources | Virtual Machine Version: 8
| (& Add Hardware x

Select a Disk

Device Tvpe A virtual disk is composed of cne or more fles on the hast fle system. Together these

Select a Disk fles appear &2 & single hard disk bo the guest operating system.

Create a Disk

Advanced Options Selact the type of disk to use.

Ready to Complate — Disk

(¥ Create a new virtual disk

™ Use an existing virtual disk
Reuse a previously configured virtual disk.

™ Raw Device Mappings

Give yourr virkbual machine direct access to SAN. This cption allows you to
e existing SAN commands to manage the storage and continue to
atcess it using & datastore,

I,
Help | o | Cancel

Select Disk

8. Select the Create a new virtual disk radio button and click Next.
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Create Disk

9. Update the Capacity > Disk Size as specified:
Small to Medium: 400 GB, (Initial size 200 GB, increasing total space to 600 GB)
Small to Large: 1000 GB, (Initial size 200 GB, increasing total space to 1200 GB)
10. Select the Thin Provision radio button for Disk Provisioning.
11. Click Next. The Advanced Options window displays.
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Hardware | Options | Resources | Virtual Maching Verson: 3
| (5 Add Hardware b4
Advanced Options

These advanced opbons do not usualy need to be changed.

Revice Type Speafy the advanced opbons for this virtual disk, These opbons do not normaly need
Salect 3 Disk to be changed.
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- Mode
™ Independent
Independent dsks are not affected by snapshats,
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Advanced Options

12. Do not make changes. Click Next to continue.
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Virtual Machine Yersion: 8

| (5 Add Hardware

Ready to Complete
Review the selected options and didk Finish to add the hardware,

Daicm Typs Optiona:

Salacth p Dok

Create 5 Desk Hardware type: Hard Disk

Advanced Options Create disk: ew virtual disk

Ready to Complete Disk capadty: 400 GE

e Disk prowvisioning:  Thin Frovision

Datastore: datastorel (11)
Virtual Device Node: 5081 (0:1)
Disk mode: Pergstent
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Ready to Complete

13. Click Finish.
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14. Click OK to complete the reconfiguration. The completed reconfiguration displaysin the Recent
Tasks panel.
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Note: Configuration changes take approximately five minutes to complete.

Reconfiguring Using Web Client ESXi v6.0

To update VM configurations using Web Client ESXi v6.0:



ESXi Client

1. Loginto the VMware ESXi Client. The Home page displays.

ESXi Home Page

2. Click Virtual Machineto display alist of VMs.
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4. Click Actions and select Edit Settings. The Edit Settings window opens.
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& Edit settings - CXCloudAgent_2.2_ Build-DEV-build-7-10.126.77.243 (ESXi 5.0 virtual machine)

m—]"‘I = npt I¢n s

£} Add hard disk B Add nelwork adapter ] Add other device

Je

5 GB
S B Memory
200 GB - *
» (£ Hard disk 1
4% SCS1 Conbrolier O
» '8 Motwork Adapier 1 Wi Mebwork . Conmact *

» B Floppy drive 1

b :I ideo Card

e -

k.

Edit Settings

5. Update the CPU value as specified:
Medium: 16 core (8 sockets * 2 core/socket)
Large: 32 core (16 sockets * 2 core/socket)
6. Update the M emory value as specified:
Medium: 32 GB
Large: 64 GB
7. Click Add hard disk > New standard hard disk. The new hard disk entry displays in the Edit
settings window.



'@ Edit settings - CXCloudAgent_2.2_Build-DEV-build-7-10.126.77.243 (ESXi 5.0 virtual machine)
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Edit Settings

8. Update New Hard disk values as specified:
Small to Medium: 400 GB, (Initial size 200 GB, increasing total space to 600 GB)
Small to Large: 1000 GB, (Initial size 200 GB, increasing total space to 1200 GB)
9. Click the arrow to expand New Hard disk. The properties display.
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Disk Provisioning
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"& Edit settings - CACloudAgent_2.2_Build-DEV-build-7-10.126.77 243 (ESXi 5.0 virtual machine)
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10. Select the Thin provisioned radio button.
11. Click Save to complete the configuration. The configuration update displays in the Recent tasks.
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Reconfiguring Using Web Client vCenter

To update the VM configurations using the Web Client vCenter:



VMware” vSphere

o wamphefhdoman sl

Padiwond

U WINGCw . SEion uthenbcation

LOGIN

vCenter

1. Loginto vCenter. The Home page displays.
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2. Right-click the target VM and select Edit Settings from the menu. The Edit Settings window opens.



Edit Settings
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Edit Settings

3. Update the CPU values as specified:
Medium: 16 core (8 sockets * 2 core/socket)
Large: 32 core (16 sockets * 2 core/socket)

4. Update the Memory values as specified:

Medium: 32 GB
Large: 64 GB
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Edit Settings = CXCloudAgent_2.2_Build-DEV-build-7-10.126.77,243 .
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Edit Settings

5. Click Add New Device and select Hard Disk. The New Hard disk entry is added.
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Edit Settings

6. Update New Hard disk memory as specified:
Small to Medium: 400 GB, (Initial size 200 GB, increasing total space to 600 GB)
Small to Large: 1000 GB, (Initial size 200 GB, increasing total space to 1200 GB)




Edit Settings @ CxCloudaAgent_2.2_Build-DEV-build-7-10.126.77.243 X
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7. Select Thin Provision from the Disk Provisioning drop-down list.
8. Click OK to complete the upgrade.

Deployment and Networ k Configuration

Select any of these options to deploy the CX Cloud Agent:

VMware vSphere/vCenter Thick Client ESXi 5.5/6.0

VMware vSphere/vCenter Web Client ESXi 6.0 or Web Client vCenter Installation
Oracle Virtual Box 7.0.12

Microsoft Hyper-V Installation

OVA Deployment
Thick Client ESXi 5.5/6.0 I nstallation

This client allows deployment of CX Cloud Agent OV A by use of the vSphere thick client.


https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc10
https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc11
https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc12
https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc13
https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc14

1. After downloading the image, launch the VMwar e vSphere Client and log in.

[E! Viiware viphere Client b4

vmware

VMware vSphere

Client

.—-1-“'-:. All wSphere features introduced in vSphere 5.5 and beyond are
avaiable only through the vSphere Web Client. The traditional
vophers Chent will conbinue to operate, supporting the same
feature set as vSphere 5.0,

To drectly manage a single host, enter the I¥ address or host name.
To manage multiple hosts, enter the IP address or name of a
vCenter Server,

TP address [ Mame: 10. 126, 77.60
Usar name: rat

Password: inininioi)

Login

2. From the menu, select File> Deploy OVF Template.
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vSphere Client

3. Browse to select the OV A file and click Next.



(% Deploy OVF Template -

Source
Select the source location,

Source

OV Tierrga bee Dot
Mame and Location
Disk Format

Resdy to Comphebe
Deploy from & file or URL

' =l owse... |

Enter & LRL to downboad and install the OWF package from the Internet, or
mfrihnlmaﬂnmhhﬁwmm such as a local hard drive, @
network share, or & CDDVD drive

OVA Path

4. Verify the OVF Details and click Next.



(2] Drepioy OVF Template

VT Template Oertaib
ety CAF tesplate detal

T e ]

e e P

m:.i':.lw.;. werpon

By 1= Compiets vendor:
Prubdiher;
Digwamicus e
Sizw o dlinkc:
Dwscriphion:

oy Fysbema, [ng
€ CIE00 SrETIMG, P
L3168

3.1 GH (Ehin provasoned]
i:lll".ﬂlilltl'dm-ﬂ
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Template Details

5. Enter aUnique Name and click Next.




() Deploy OVF Template -

Hame and Location
Epenfy a name and locabon fiyr the deployed template

SourCE

g

Mame and Location
Disk Format The rame can contsin up to B0 charachers and it must be unigue within e imentory folder,

MNetwark Mapnirg
Ready to Complets

_ v | st || [Tt

Name and Location

6. Select aDisk Format and click Next (Thin Provision is recommended).



(<) Deploy OVF Template

Disk Format
Ir witich Bormat do wou want by shore the virtual disks?

i Datastore:

QUF Tempiate Detads ) atastore1 (11
Hame and Location Available saacs (GB): T
Disk Formak =)

Maztwerl; Mappeng

Rmsdy Gy Compiebe
™ Thick Provision Lazy Zeroed
" Thick Provision Eager Zeroed
(¥ Thin Provision

4o | <o ||

Disk Format

7. Select the Power on after deployment check box and click Close.




@ l:li:-plp:,' OVF Template = (| =

Ready to Complete
Are these the opbons you want bo use?

&ﬁ;wﬂﬂ D Epis When you dick Finish, the deployment task will be started.
hame sod Location Deployment settings:
rmr! FE:’;E! OVE File: CriUsersioocadminiDovnloads WOVALCXCloudAgent 20.
etk Macpeg Download sie 1.1G8
Ready to Complete Sizeondigk: 3168
Hama: CiClawdhgent_2.0_Build-144 DEMO
Hast Cluster |lacalhast
Diataskore datastorel (11}
Disk provisoeieg: Thén Provisien
Network Mappag: WM Network™ to "M Nebwork™

¥ [Pawer on after deployment]

_ o | _c<oox || emon | oo |

Ready to Complete

Deployment can take several minutes. Confirmation displays upon successful deployment.
@ Deployment Completed Successfully — X
Deploying CXCloudAgent_2.0_Build-144_DEMO

Completed Successfully

|t:lase|

8. Select the deployed VM, open the console, and go to Network Configuration to proceed with the next
steps.

Deployment Complete




Web Client ESXi 6.0 Installation

This client deploys CX Cloud Agent OV A by use of the vSphere web.

1. Loginto the VMWare Ul with the ESXi/hypervisor credentials used for deploying VM.

vimware ESxi

VMWare ESXi Login

2. Select Virtual Machine > Create/ Register VM.
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Create VM

3. Select Deploy a virtual machine from an OVF or OVA file and click Next.



0 merw vl Eaching

LI  Select creation type
2 Saect OVE 2 VIIDW, Bles.

3 Sebert sl npe

§ LoC i ST EPmeats,

5W==‘=|| CrEaE 3 new il Mg

B Al gy Oeppion 3 virtugl rmpchirsg from an OWF of Crik B

Heri wrteuld y0u Wi o ore a0 3 Yirkual LRacrene Y

- Tl Opleces (it p0i B Oniph Wi POk S B OF T8 300 3
ariis Facherss irom a0 OFF and WD il

Figeiier an wsiBng wiisd machng

Select Creation Type

4. Enter the name of the VM, browse to select the file, or drag-and-drop the downloaded OV A file.
5. Click Next.

Lelect OVF and VMDK files
St c T CVF 2] VUICHC S oo G, for ot VIl ross wioruld o B0 deploy

Ended 3 naarrel Ao Bt riul machane
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OVA Slection

6. Select Standard storage and click Next.
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7. Select the appropriate Deployment options and click Next.
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Deployment Options

8. Review the settings and click Finish.
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Successful Completion

9. Select the VM just deployed and select Console > Open browser console.
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Console

10. Navigate to Network Configuration to proceed with the next steps.

Web Client vCenter Installation

Perform these steps:

1. Log into vCenter Client using ESXi/hypervisor credentials.

LogIn

2. From the Home page, click Hosts and Clusters.
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3. Select the VM and click Action > Deploy OVF Template.
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Dreploy OVE Template
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Select Template

4. Add the URL directly or browse to select the OVA file and click Next.
5. Enter aunique name and browse to the location if required.
6. Click Next.




Deploy OVF Template
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7. Select a compute resource and click Next.



Deploy OVF Template
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Select Computer Resource

8. Review the details and click Next.



Deploy OVF Template
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9. Select the virtual disk format and click Next.
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Select Storage

10. Click Next.



Deploy OVF Template
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Select Network

11. Click Finish.
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Ready to Complete
12. Click the name of the newly added VM to view the status.
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VM Added

13. Onceinstalled, power on the VM and open the console.
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Open Console

14. Navigate to Network Configuration to proceed with the next steps.

OracleVirtual Box 5.2.30 I nstallation

This client deploys CX Cloud Agent OV A though the Oracle Virtual Box.

1. Open the Oracle VM Ul and select File> Import Appliance.
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Oracle VM

2. Browse to import the OVA file.



Slect File

3. Click Import.

Aopliarce g impast

P pre e poaron o et pocdaeo o M cae- b s Pl e b o OHT eciiee o ooe ! ireee cead e

e b s clgaad i P
fwace  Loos Nia Fnfies

P [Pl B B Al D e el Pt O W Tkl S Ll L PRl e, Al o Tk

bl ] et ol (P Lo P L e Pl B PR D
Vim 8 paern el b pigy Dapmerdrngefin ] 01 LT iyl g 3 0 Bade] - Ll 1o pFiy ' e

L] bicedin

= Bk

[ 13



Applianca wrtiing.
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4. Select the VM just deployed and click Start.
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5. Power on the VM. The console displays.
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6. Navigate to Network Configuration to proceed with the next steps.

Microsoft Hyper-V Installation

Perform these steps:
1. Select Import Virtual Machine.
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Hyper V Manager

2. Browse and select the download folder .
3. Click Next.



Py Bl Worar g
+= =z BT
B ¥ Mg - -

Hgmty Wk Shoes (SRR Mol ol BT W
Foider: |

Folder to Import

4. Select the VM and click Next.



Select VM

5. Select the Copy the virtual machine (create a new unique D) radio button and click Next.



Choose Import Type
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Import Type

6. Browse to select the folder for VM files. It is recommended to use the default paths.
7. Click Next.



/P | Choose Folders for Virtual Machine Files
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Choose Foldersfor Virtual Machine Files

8. Browse and select the folder to store the VM hard disk. It is recommended to use default paths.
9. Click Next.



Chovse Folders to Store Virtual Hard Disks
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10. The VM summary displays. Verify all inputs and click Finish.




Completing Import Wizard

Foay e about s perform e folowing operalion.
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Summary

11. Once the import is completed successfully, anew VM is created on Hyper-V. Open the VM setting.
12. Select the networ k adaptor on the left pane and choose the available Virtual Switch from the drop-
down.
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Virtual Switch

13. Select Connect to start the VM.
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Sarting VM

14. Navigate to Network Configuration to proceed with the next steps.

Networ k Configuration

1. Click Set Password to add a new password for cxcadmin OR click Auto Gener ate Password to get a
new password.

Set Password

2. If Set Password is selected, enter the password for cxcadmin and confirm it. Click Set Password and
go to Step 3.



Zet Fagiuord

Im the Password and Conf irm Password fields. ewter and comf ire & new password for
cucadmin. When gou are inizshed. select 5ot Pasoword

(lge the Up frrou amd Dous frrou keygs (o navigate betuees Ficlds.
Presz the Tab oy to select Set Password )

Ikt e name crcadmin

New Password

OR

If Auto Generate Password is selected, copy the password generated and store it for future use.
Click Save Password and go to Step 4.

futogrocrated Passuord

Fassuord | 300 MOOWIONGT

Hake smre to store this passeord im a zafe place. This passeord is required to log
inte Cizoo O Cloud Agent.

Micr you have stored the pazsword in a zafe place, zelect Save Pazsword, To return
to the previoms screen, sslect Cancel,

£ Cance | &

Auto Generated Password

3. Click Save Password to useit for authentication.
l'.u.nlnrd Strength

The sireegih of the new pazsuard iz Aedium,

To save the password, select Save Password. To configure a differest password,
gelect Cancel o refurn to the 3ot Fazsword screem.

£ Lance | >

Save Password

4. Enter the | P Address, Subnet Mask, Gateway, and DNS Server and click Continue.



Network Conf iguration .

Please enter an IFvd address amnd corresponding network configuration
for the appliance.

(Use UpsDown keys to navigate to next Field. Press Tab to jump to
Cont inue button)

IF Address: I
Subnet Hask: === = T~ P T
Gateway: -
DHS Servers: -1
wHaximum 3 IPs with comma separator,

Lok | naied

Network Configuration

5. Confirm the entries and click Y es, Continue.
Coml’ lirmat fom

fire these eniries correct?

IF Address:
Subeel Mask:

Glthﬂl!
1, b

i¥en, Cont | mhie s % o, o Back ¥

Configuration

6. To set the proxy details, click Yes, Set Up Proxy or click No, Continueto Configuration to
complete the configuration, and go to Step 8.

Proony Set Up Conf irmation
bo you want to add proxy detailsz?

Yes, 3o i ; i Mo, Contimee to Conl igurat londk

Proxy Setup

7. Enter the Proxy Address, Port Number, Username, and Passwor d.



Prooy Conmf iguration

Please enter proxy details for the network.

(e UpsDoun keys to mavigate to next field. Press Tab to jump to Setup

Proxy button)

Proxy Address: 1

Port Nunber: I

Usernane : I

Password : S
<Begin Conf igurat ion ¢ Mo, Go Back >

Proxy Configuration

8. Click Begin Configuration.

Clocs X Closd fgentl Conl | parat lon

Ualidate the donaing connectivity. Plesse press Contimes
and waltl for & while. ..

Begin Configuration

9. Click Continue.
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Configuration Continues

10. Click Continue to proceed with the configuration for successful domain reach. The configuration can
take several minutes to complete.

% Note: If the domains cannot be reached successfully, the customer must fix domain reachability
by making changes in their firewall to ensure that domains are reachable. Click Check Again
once the domains reachability issue is resolved.

Cimoo (X Closd Agent Sctap

Conf lguration is imn progress. ..
Thiz step will take B-10 nimtes to oosplete.

Ba ol poesr of I the mechins ant il thiz process ie oomplebed ,

i

Configuration in Progress

11. Copy the Pairing Code and return to CX Cloud to continue the setup.



isoo O Cloud Agent Setup
The notwork coaf iguration hax been succezzifully compleoied,

IF
Subnotl Hazk

it iy
S St

The pairing code is

Flease go o CX Cloud and emfer thic palring code.
The Code will b walid Tor 5 nimutes,

Tir= left In seconds. ..

Pairing Code

12. If the Pairing Code expires, click Register to CX Cloud to obtain the code again.
Falring Code Doplred

The mtisork comf lguration kai boen tsdoetifolly compleied.

iF i
Subneti Razk
ik i H
BME Srrerr

To rogeecrals the pairing code FREES key CRegister Lo OX Clomdd

Code Expired

13. Click OK.

Begiztration Saccezzful

CX Cloud Agent setup is conplete. Please go to CX Cloud to start using the
waluable data provided by CX Cloud fgent.

Registration Successful

Alternative Approach to Generate Pairing Code Using CL |

Users can also generate a pairing code by using CLI options.

To generate a pairing code using CLI:



1. Loginto the Cloud Agent via SSH using the cxcadmin user credential.
2. Generate the pairing code using the command cxcli agent gener atePairingCode.

g e 1l et g TEPad el eplede

Generate Pairing Code CLI

3. Copy the Pairing Code and return to CX Cloud to continue the setup.

Configure Cisco Catalyst Center To Forward Syslog to CX Cloud Agent
Prerequisites

Supported Cisco Catalyst Center versionsare 2.1.2.0t0 2.2.3.5, 2.3.3.4 t0 2.3.3.6, 2.3.5.0, and Cisco
Catalyst Center Virtual Appliance

Configure Syslog Forward Setting

To configure Syslog Forwarding to CX Cloud Agent in the Cisco Catalyst Center, perform these steps:

1. Launch Cisco Catalyst Center.
2. Go to Design > Network Settings >Network.
3. For each site, add the CX Cloud Agent IP as the Syslog Server.

L cd ol h 5 [ r Y 5 Al B N

Syslog Server

% Note: Once configured, al devices associated with that site are configured to send syslog with level
critical to CX Cloud Agent. Devices must be associated to a site for enabling the syslog forwarding
from the device to CX Cloud Agent. When a syslog server setting is updated, all devices associated
with that site are automatically set to default critical level.



Configure Other Assetsto Forward Syslogto CX Cloud Agent

Devices must be configured to send Syslog messages to the CX Cloud Agent to use the Fault Management
feature of CX Cloud.

N Note: Only Campus Success Track Level 2 devices are eligible to configure other assetsto forward
syslog.

Existing Syslog Serverswith Forward Capability

Perform the configuration instructions for the syslog server software and add the CX Cloud Agent IP
Address as a new destination.

% Note: When forwarding syslogs, ensure that the source |P address of the original syslog messageis
preserved.

Existing Syslog Serverswithout Forward Capability OR without Syslog Server

Configure each device to send syslogs directly to the CX Cloud Agent IP Address. Refer to
this documentation for specific configuration steps.

Cisco 10S® XE Configuration Guide

AireOS Wireless Controller Configuration Guide

Enable Information Level Syslog Settings

To make Syslog Information level visible, perform these steps:

1. Navigate to Tools>Telemetry.


https://www.cisco.com/c/en/us/td/docs/switches/lan/catalyst9300/software/release/17-1/configuration_guide/sys_mgmt/b_171_sys_mgmt_9300_cg/configuring_system_message_logs.html
https://www.cisco.com/c/en/us/td/docs/wireless/controller/8-10/config-guide/b_cg810/configuring_system_and_message_logging.html
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Discovery

Inventory

Topology

Image Repository

Command Runner
License Manager
Template Editor
Telemelry

Data and Reports




Tools Menu

2. Select and expand the Site View and select asite from site hierarchy.

Cisco Dt

argalcrs

......

Ste View

3. Select the required site and select all devices using the Device name check box.

4. Select Optimal Visibility from the Actions drop-down.
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Actions

Back Up and Restorethe CX Cloud VM

It is recommended to preserve the state and data of a CX Cloud Agent VM at a specific point in time using
the snapshot feature. This feature facilitates CX Cloud VM restoration to the specific time that the snapshot

is taken.

Back Up

To back up the CX Cloud VM:

1. Right-click the VM and select Snapshot > Take Snapshot. The Take Virtual Machine
Snapshot window opens.
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Select VM

—Name
[Snapshot_Name <Provide_Snapshot_name >

— Description

<Description for "ef>

[ Snapshot the virtual machine's memory
™ Quiesce guest file system (Needs VMware Tools installed)

‘ oK | Cancel

Take Virtual Machine Snapshot

2. Enter Name and Description.
% Note: Verify that the Snapshot the virtual machine’s memory check box is cleared.

3. Click OK. The Create virtual machine snapshot status displays as Completed in the Recent Tasks
list.
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What is a Virtual Machine?

A virtual machine is a software computer that, like a
physical computer, runs an operating system and
appications. An operating system installed on a virlual
maching is called a guest operating system

Because every viual machinge is an isolated computing
environment, you can use virual machines as deskiop or
workstation environments, as testing environments, or to
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consolidate server applications.

Virtual machines run on hosts. The same host can run
many virtual machines.
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Basic Tasks wSphere Client

B Power Off the virtual machine

[l Suspend the virtual machine

{p Edit virtual machine settings
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Recent Tasks
Restore

To restore the CX Cloud VM:

1. Right-click the VM and select Snapshot > Snapshot M anager. The Snapshots of the
VM window opens.
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Snapshots Window

2. Click Go to. The Confirm window opens.
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3. Click Yes. The Revert snapshot status displays as Completed in the Recent Tasks list.
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4. Right-click the VM and select Power > Power On to power on the VM.
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Security

CX Cloud Agent assures the customer of end-to-end security. The connection between CX Cloud and CX
Cloud Agent is TLS secured. Cloud Agent’s default SSH user is limited to perform only basic operations.

Physical Security

Deploy CX Cloud Agent OVA image in a secured VMware server firm. The OVA is shared securely
through Cisco software download center. Bootloader (single user mode) password is set with arandomly
unique password. Users must refer to this FAQ to set this bootloader (single-user mode) password.

Account Security


https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#anc32

During deployment, the cxcadmin user account is created. Users are forced to set a password during the
initial configuration. cxcadmin user/credentials are used to access both the CX Cloud Agent APIsand to
connect to the appliance over SSH.

cxcadmin users have restricted access with the least privileges. The cxcadmin password follows the security
policy and is one-way hashed with an expiry period of 90 days. cxcadmin users can create a cxcroot user
using the utility called remoteaccount. cxcroot users can gain root privileges.

Network Security

The CX Cloud Agent VM can be accessed using SSH with cxcadmin user credentials. Incoming ports are
restricted to 22 (SSH), 514(Syslog).

Authentication

Password based authentication: Appliance maintains a single user (cxcadmin) which enables the user to
authenticate and communicate with the CX Cloud Agent.

* Root privileged actions on the appliance using SSH.

cxcadmin users can create cxcroot user using a utility called remoteaccount. This utility displays an
RSA/ECB/PKCS1v1 5 encrypted password which can be decrypted only from the SWIM portal

(DECRY PT Request Form). Only authorized personnel have access to this portal. cxcroot users can gain
root privileges using this decrypted password. Passphrase is valid only for two days. cxcadmin users must
recreate the account and obtain the password from the SWIM portal post password expiry.

Hardening

CX Cloud Agent appliance follows Center of Internet Security hardening standards.

Data Security

CX Cloud Agent appliance does not store any customer personal information. Device credential application
(running as one of the pods) stores encrypted server credentials inside secured database. The collected data
isnot stored in any form inside the appliance except temporarily when it is being processed. Telemetry data
is uploaded to CX Cloud as soon as possible after the collection is complete and is promptly deleted from
local storage after it is confirmed that the upload was successful.

Data Transmission

The registration package contains the required unique X.509 device certificate and keys to establish secure
connection with lot Core. Using that agent establishes a secure connection using Message Queuing
Telemetry Transport (MQTT) over Transport Layer Security (TLS) v1.2

L ogs and Monitoring

L ogs do not contain any form of Personal Identifiable Information (PIl) data. Audit logs capture all security-
sensitive actions performed on the CX Cloud Agent appliance.

Cisco Telemetry Commands

CX Cloud retrieves asset telemetry using the APIs and commands listed in the Cisco Telemetry Commands.
This document categorizes commands based on their applicability to the Cisco Catalyst Center inventory,



https://swims.cisco.com/abraxas/decrypt
https://docs.aws.amazon.com/iot/latest/developerguide/x509-client-certs.html
https://www.cisco.com/c/dam/en/us/support/docs/cloud-systems-management/Cisco-CX-Collector/cisco-telemetry-commands.pdf

Diagnostic Bridge, Intersight, Compliance Insights, Faults, and all other sources of telemetry collected by
the CX Cloud Agent.

Sensitive information within asset telemetry is masked before being transmitted to the cloud. The CX Cloud
Agent masks sensitive data for all the collected assets that send telemetry directly to the CX Cloud Agent.
This includes passwords, keys, community strings, usernames, and so on. Controllers provide data masking
for al controller-managed assets before transferring this information to the CX Cloud Agent. In some
instances, controller-managed assets telemetry can be anonymized further. Refer to the corresponding
product support documentation to learn more about anonymizing the telemetry (for example, the Anonymize
Data section of the Cisco Catalyst Center Administrator Guide).

While thelist of telemetry commands cannot be customized and the data masking rules cannot be modified,
customers can control which assets' telemetry CX Cloud accesses by specifying data sources as discussed in
the product support documentation for controller-managed devices or the Connecting Data Sources section
of this document (for Other assets collected by CX Cloud Agent).

Security Summary

Security Features |Description

Bootloader (Single user mode) password is set with arandomly unique password.

Bootloader Password Users must refer to FAQ to set his bootloader (single user mode) password.

SSH:

Access to appliance using cxcadmin user requires credentials created during
User Access installation.

Access to appliance using cxcroot user requires credentials to be decrypted using
SWIM portal by authorized personnel.

cxcadmin: default user account created; User can execute CX Cloud Agent
application commands using cxcli and has least privileges on the appliance; cxcroot

User Accounts user and its encrypted password is generated using cxcadmin user.

cxcroot: cxcadmin can create this user using the utility remoteaccount; User can
gain root privileges with this account.

Password is one-way hashed using SHA-256 and stored securely.
cxcadmin password

policy - Minimum eight (8) characters, containing three of these categories: uppercase,
lowercase, numbers, and special characters.

cxcroot password is RSA/ECB/PKCS1v1 5 encrypted

cxcroot password -+ The passphrase generated needs to be decrypted in SWIM portal.
policy

The cxcroot user and password is valid for two days and can be regenerated
using cxcadmin user.



https://www.cisco.com/c/en/us/support/cloud-systems-management/index.html
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-5/admin_guide/b_cisco_dna_center_admin_guide_2_3_5/b_cisco_dna_center_admin_guide_2_3_5_chapter_010.html#id_122699
https://www.cisco.com/c/en/us/td/docs/cloud-systems-management/network-automation-and-management/dna-center/2-3-5/admin_guide/b_cisco_dna_center_admin_guide_2_3_5/b_cisco_dna_center_admin_guide_2_3_5_chapter_010.html#id_122699
https://www.cisco.com/c/en/us/support/cloud-systems-management/index.html
https://www.cisco.com/c/en/us/support/docs/cloud-systems-management/cx-cloud-agent/217292-cx-cloud-agent-overview.html#Grub

Minimum of eight characters that contains three of these categories. uppercase,

ssh login p ord lowercase, numbers, and special characters.

policy Fivefailed log in attempts lock the box for 30 minutes; Password expiresin 90
days.
Ports Open Incoming Ports — 514(Syslog) and 22 (SSH)
No Customer information stored.
Data Security - No Device data stored.

Cisco Catalyst Center server credentials encrypted and stored in the database.




